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Chapter 1. About Gentleware and
Apollo for Eclipse
About Gentleware and Apollo for Eclipse

Contact
We are always very happy to get feedback on our tools and services. If you want to contact us, there are
several ways to get in touch.

Email

The easiest way to contact us is via the web form. We offer addresses for different purposes.

General information, feature requests, or suggestions:

http://www.gentleware.com/contact.html

Customer support (for license holders*):

Please keep in mind that our customer support is available during our normal working hours - Monday
through Friday, 9 am to 6 pm Central European Time. Consider checking the forums and the FAQ to
answer your question first.

http://www.gentleware.com/supportreq.html

Questions on purchase process, quotes, or volume sales:

sales@gentleware.com [mailto:sales@gentleware.com]

* Unlicensed edition users are encouraged to use our forum for support questions.

http://www.gentleware.com/fileadmin/forum.html

Web Site

For general discussion we have installed an open forum [http://www.gentleware.com/fileadmin/
forum.html] in which users of Apollo for Eclipse can freely discuss topics related to our tools. Typically
these are questions on how to do something, discussions on what other features would be nice, or comments
on what people like or dislike about our tool. Our staff is actively taking part in these discussions, but you
might also get a response from other users.

To order our products you can use the online shop [http://www.gentleware.com/shop0.html], which
requires a credit card. If you do not have a credit card or you hesitate to use it over the web, send us an
email at sales@gentleware.com [mailto:sales@gentleware.com].

Phone

Our preferred payment method is credit card. However, if you do not have a credit card or you
hesitate to use it over the web, you can also send a fax, send email to sales@gentleware.com
[mailto:sales@gentleware.com] or call us.

There is a fax order sheet provided on our web site. Begin the order process as usual, then select 'Order by
Fax' at the bottom of the Checkout page. Our fax number is +49 40 2442 5331.

http://www.gentleware.com/contact.html
http://www.gentleware.com/supportreq.html
mailto:sales@gentleware.com
mailto:sales@gentleware.com
http://www.gentleware.com/fileadmin/forum.html
http://www.gentleware.com/fileadmin/forum.html
http://www.gentleware.com/fileadmin/forum.html
http://www.gentleware.com/fileadmin/forum.html
http://www.gentleware.com/shop0.html
http://www.gentleware.com/shop0.html
mailto:sales@gentleware.com
mailto:sales@gentleware.com
mailto:sales@gentleware.com
mailto:sales@gentleware.com
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Please try to find an answer to your question on our web pages [http://www.gentleware.com/support.html]
or the FAQ list [http://www.gentleware.com/faq.html].

Regular Mail

To send us mail or to visit us in person, our address is:

Gentleware AG
                        Ludwigstraße 12
                        20357 Hamburg
                        Germany 

Features in Version 3.x
Feature list includes:

• Forward, reverse, and roundtrip engineering

• Support for Java 5

• Support for UML 2.1

• Superior class diagram handling

• Available as a standalone RCP or as an extension to Eclipse

• GMF 2.0 and Eclipse 3.3

• Array dimension support for attributes

• Configurable location of model files

About This Document
This document describes Apollo for Eclipse and how to use it. It is intended as a user guide. It is not a
book about UML, Java, or Eclipse. Basic knowledge about UML, Java, and Eclipse is assumed.

We are working hard to make Apollo for Eclipse as intuitive as possible. You should be able to open up
Apollo for Eclipse and start using it without looking into this documentation. However, you will find it
useful to read through this document to get you up to speed faster and discover useful features earlier.

http://www.gentleware.com/support.html
http://www.gentleware.com/support.html
http://www.gentleware.com/faq.html
http://www.gentleware.com/faq.html
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Chapter 2. Installation and First Start

Prerequisites
Apollo for Eclipse is platform-independent. It runs on almost any modern personal computer. To
successfully start and run Apollo for Eclipse, you need the following:

• J2SE 5.0 Java Runtime Environment

• A computer with reasonable memory and CPU power. For memory, 512 MB is recommended, more is
helpful. For CPU, a Pentium III or equivalent is the recommended minimum.

Installing the Rich Client Platform
The easiest way to get started with Apollo for Eclipse is to use the Rich Client Platform (RCP). Download
the RCP zip file (e.g. for Windows:  Apollo_RCP_3.0.0_win32.win32.x86.zip) from the
Gentleware web site, unpack the file to the desired directory, and run Apollo for UML from this directory.

Installing as an Eclipse Extension
Apollo for Eclipse may also be added as an extension to the Eclipse IDE. It requires some features to be
installed to Eclipse in addition to the Apollo for Eclipse extension. The simplest way to do this is using
Eclipse Europa, although you may also choose to install each part manually.

Additionally, you will need to consult the Eclipse documentation for the prerequisites that match your
usage scenario and computer setup. The exact list of requirements for running Apollo for Eclipse as an
extension can be found later in the section the section called “Install Eclipse Components Manually”.

Install Eclipse Components through Update Services
This is the standard Eclipse way of installing features, and is also an easy way to complete the installation.
Gentleware recommends using this method of installation.

1. If it is not already installed, install the Eclipse SDK 3.3.x (the current version as of the publication of
this document is 3.3.0).
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2. Start Eclipse. From the Help menu, select Software Updates -> Find and Install...

3. Select 'Search for new features to install' and click 'Next'.

4. If it does not appear already, add the Apollo for Eclipse Update Site as a New Remote Site:

-> New Remote Site
-> Name = "Apollo for Eclipse Update Site"
-> URL = "http://apollo.gentleware.com/updatesite/"

5. There are 5 different versions of Eclipse 3.3 Europa: Eclipse IDE for Java Developers, Eclipse IDE for
Java EE Developers, Eclipse IDE for C/C++ Developers, Eclipse for RCP/Plug-in Developers, and
Eclipse Classic.

If you are using the RCP/Plug-in Developers or Eclipse Classic, select "Apollo for Eclipse Update
Site" and "Europa Discovery Site".

If you are using one of the IDE versions, you must also install the org.eclipse.sdk feature via
The Eclipse Project Update. Check "The Eclipse Project Update" in addition to "Apollo
for Eclipse Update Site" and "Europa Discovery Site".

Check the remote site, check "Ignore features not applicable for this environment", and uncheck
"Automatically select mirrors". Click "Finish".



Installation and First Start

5

Note

Some of the mirrors for Eclipse plug-ins don't offer the same content as the original update
site. Please be sure to use the original site: http://apollo.gentleware.com/updatesite/

6. Open Apollo for Eclipse Update Site -> Apollo for Eclipse -> Apollo 3.0.

7. Click "Select Required", then click "Next".

8. Carefully read the license texts, then accept the licenses. Click "Next".

http://apollo.gentleware.com/updatesite/


Installation and First Start

6

9. Check Locations and click "Finish".

Eclipse Europa

There are three main steps to install Apollo for Eclipse. First an update is made through Europa, then the
UML2 Eclipse project is installed, and finally Apollo for Eclipse is installed. The method described here
works, but will install many more features than are required by Apollo for Eclipse and take up much more
disk space than using the method described in the section called “Install Eclipse Components through
Update Services”.

1. Europa Installation
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a. If it is not already installed, begin by installing Eclipse SDK version 3.3 or higher. The download
is available from 'Eclipse downloads home [http://www.eclipse.org/downloads/]' on the Eclipse
website. Simply download the zip file and extract them to a directory on your system.

Note

On Windows systems, it is not recommended to extract the files to the 'Program Files'
directory. The white space in the file name may cause problems with some extensions or
compilers.

b. Start Eclipse. From the Help menu, select Software Updates -> Find and Install...

c. Select 'Search for new features to install' and click 'Next'.

d. Select the 'Europa Discovery Site' and click 'Finish'.

http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/
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e. The Update Manager will search for a list of mirror sites.

Select the mirror nearest you and click 'OK'.

f. Select the 'Europa Discovery Site' and click 'Next'.
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g. Accept the license agreements and click 'Next'.

h. Click 'Finish' to install the components.
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The Update Manager will install the components.

Shut down Eclipse after the installation is complete.

i. In the Eclipse installation folder, create the file eclipse.ini if it does not exist. Add or edit the
following in eclipse.ini:

-vmargs
-Xms64m
-Xmx512m
-XX:MaxPermSize=128m
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2. Install the UML2 Project

a. Download the UML2 project uml2-SDK-2.1.0.zip from the Eclipse site [http://
www.eclipse.org/uml2/].

b. Extract the zip file to the Eclipse installation.

3. Install Apollo for Eclipse

a. Download Apollo for Eclipse  Apollo_3.0.0.zip from the Gentleware website [http://
www.gentleware.com/downloadcenter.0.html].

b. Extract the zip file to the Eclipse installation.

4. Start Eclipse.

Install Eclipse Components Manually
The third and least recommended option for installing Apollo for Eclipse is to install the required features
manually. The table below lists the necessary features:

Table 2.1. Minimum Eclipse features required for Apollo for Eclipse

Feature Version Number

eclipse-SDK 3.3

EMF Service Data Objects (SDO) SDK 2.3

OCL SDK 1.1.0

EMF Model Query SDK 1.1.0

EMF Model Transaction SDK 1.1.0

EMF Validation Framework SDK 1.1.0

Graphical Editing Framework SDK 3.3.0

Graphical Modeling Framework SDK 2.0.0

Apache Batik 1.6.0 (included in GMF-SDK)

UML2 SDK 2.1.0

1. Install all of the Eclipse features listed above.

2. Download the UML2 project uml2-SDK-2.1.0.zip from the Eclipse site [http://
www.eclipse.org/uml2/].

3. Extract the zip file to the Eclipse installation.

4. Download Apollo for Eclipse  Apollo_3.0.0.zip from the Gentleware website [http://
www.gentleware.com/downloadcenter.0.html].

5. Extract the zip file to the Eclipse installation.

6. Start Apollo for Eclipse.

7. In the Eclipse installation folder, create the file eclipse.ini if it does not exist. Add or edit the
following in eclipse.ini:

-vmargs

http://www.eclipse.org/uml2/
http://www.eclipse.org/uml2/
http://www.eclipse.org/uml2/
http://www.gentleware.com/downloadcenter.0.html
http://www.gentleware.com/downloadcenter.0.html
http://www.gentleware.com/downloadcenter.0.html
http://www.eclipse.org/uml2/
http://www.eclipse.org/uml2/
http://www.eclipse.org/uml2/
http://www.gentleware.com/downloadcenter.0.html
http://www.gentleware.com/downloadcenter.0.html
http://www.gentleware.com/downloadcenter.0.html
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-Xms64m
-Xmx512m
-XX:MaxPermSize=128m

Troubleshooting
When running Linux GTK+
& GEF, some elements don't
appear.

Linux GTK+ and GEF don't always work well together, depending on
the versions used. If some elements are not appearing, disable anti-
aliasing in the Apollo preferences (Window->Preferences->Apollo).

The following has been taken from the Eclipse Project Release Notes 3.2.1 [http://www.eclipse.org/
eclipse/development/readme_eclipse_3.2.1.html].

Installation/Configuration
issues that can cause Eclipse to
fail start

Here are some common problems that can cause Eclipse not to start:

• Eclipse 3.2 requires at least a 1.4.2 VM. Perhaps an older version
of the VM is being found in your path. To explicitly specify which
VM to run with, use the Eclipse -vm command-line argument.

• Eclipse must be installed to a clean directory and not installed
over top of a previous installation. If you have done this
then please re-install to a new directory. If your workspace
is in a child directory of your old installation directory,
then see the instructions on "Upgrading Workspace from
a Previous Release [http://www.eclipse.org/eclipse/development/
readme_eclipse_3.2.1.html#upgrading]".

• Java sometimes has difficulty detecting whether a file system is
writable. In particular, the method java.io.File.canWrite() appears
to return true in unexpected cases (e.g., using Windows drive
sharing where the share is a read-only Samba drive). The Eclipse
runtime generally needs a writable configuration area and as a result
of this problem, may erroneously detect the current configuration
location as writable. The net result is that Eclipse will fail to start
and depending on the circumstances, may fail to write a log file with
any details. To work around this, we suggest users experiencing
this problem set their configuration area explicitly using the -
configuration command line argument.

Installing plug-ins by unzipping
them into the plugins directory

If you have installed new plug-ins and they aren't showing up when
you run, then perhaps you unzipped them into your "plugins" directory

http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html#upgrading
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html#upgrading
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html#upgrading
http://www.eclipse.org/eclipse/development/readme_eclipse_3.2.1.html#upgrading
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and your configuration might need to be refreshed. This can be
accomplished by starting Eclipse with the -clean command line
argument.

XML files with UTF-8 byte
order mark fail to have content
type detected

Eclipse will fail to detect the proper content type for XML files that
have a UTF-8 byte order mark if Crimson is the XML parser (as it is
on Sun 1.4 JREs, but not on Sun 1.5 JREs). This problem will prevent
actions normally available when files of the affected content types are
selected from being presented to the user. The workaround is to ensure
the default XML parser supports UTF-8 BOMs (such as Xerces does).

No branding with old config.ini If you have an old config.ini file and use it with a new
Eclipse build, you may not get the correct product branding.
This is because the id of the standard Eclipse product changed.
Users in shared install scenarios may end up in this situation as
previous builds of Eclipse automatically generated config.ini
files in some cases. The work around is either to delete the
local config.ini or update the eclipse.product line to read
eclipse.product=org.eclipse.platform.ide.

Invalid characters in install
directory prevents Eclipse from
starting

Eclipse will fail to launch if installed in a directory whose
path contains certain invalid characters, including :%#<>"!. The
workaround is to install Eclipse in a directory whose path does not
contain invalid characters.

Configuration can become
invalid when removing
org.eclipse.update.configurator

When launching an Eclipse Application from within the
Eclipse IDE it is possible to select the set of plug-ins
that are included in the Eclipse Application. Removing the
org.eclipse.update.configurator plug-in from the set
of plug-ins to an existing configuration can cause the configuration
to become invalid. This can result in extra plug-ins installed in
the target application that are not resolved. To work around this,
after the org.eclipse.update.configurator plug-in has
been removed, the target configuration area should be cleared before
launching.

Help browser tool bar buttons
do not work for some
documents

The Help browser's Print, Synchronize, and Bookmark buttons do
not work for pages that are not actually installed with the product.
However, you can always use the print command in the browser's
context menu to print the page you're reading.

Help documents not displayed
in a browser or very slow
document loading (Windows
only)

If your LAN settings are not properly configured for local host access,
your Help browser might open to a blank page or display an HTTP
error instead of a help page, or you may experience long delays when
loading help documents. Your system administrator can configure
your LAN settings so that help documents can be accessed from the
local help server.

1. In the Control Panel, open Internet Options, select the
Connections tab and choose LAN Settings.

2. If your host was configured to use DHCP for IP assignment, make
sure that the "Automatically detect settings" check
box is cleared.
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3. If you use a proxy server, ensure that the "Bypass proxy
server for local addresses" is selected.

4. In "Advanced" settings for proxies, add "127.0.0.1;localhost" to
the "Exceptions" if these addresses are not listed.

5. If you are using an automatic configuration script for proxy
settings, and are not sure that the script is correct, clear the "Use
automatic configuration script" check box.

If the above steps do not fix your problem, try changing the port and
host properties on the Help > Help Server preference page.
In general, setting host to localhost or 127.0.0.1 should work. Also,
especially when running a firewall, you may want to specify port 80
or some other firewall-friendly value.

Help browser displays a blank
page

If you see a help launched with a blank page, and no errors
displayed, it can be caused by a conflict between libraries in
org.eclipse.tomcat plug-in and jars optionally installed in
JRE jre/lib/ext directory. To fix the problem, ensure that the
JRE used for running Eclipse does not contain any J2EE or Apache
jars in the jre/lib/ext directory.

OLE document crashes can
cause Eclipse to also crash
(Windows only)

If an OLE document crashes, Eclipse can crash, or the workbench
menus can become inconsistent.

Crash while editing text on
Windows XP with SP2

Some users who have installed Service Pack 2 on Windows XP have
experienced crashes while using editors in Eclipse. The workaround
is to place a working version of Windows\System32\USP10.DLL in
the Eclipse startup directory or uninstall Service Pack 2.

Eclipse does not start on Linux-
Motif with Xinerama and a
UTF-8 locale

The Linux-motif build of Eclipse does not launch properly when
run on a computer with Xinerama (provides support for dual head
monitors) and a UTF-8 locale. The workaround for this problem is to
change the locale to a non-UTF-8 value, or to disable Xinerama.

Eclipse crashes on RedHat
Linux 9 with Bluecurve (GTK+
only)

Users of the Bluecurve theme shipped with RedHat Linux 9 may
experience problems running Eclipse. These problems may include
crashes or reduced performance. We recommend changing to a
different theme.

Eclipse hangs when pasting
from an unresponsive
application (GTK only)

If the application that is supplying the clipboard material is
unresponsive, the paste operation hangs Eclipse for several minutes.
This situation can be encountered when copying from an Eclipse
target workbench, suspending the target workbench at a breakpoint
and pasting into the hosting Eclipse workbench.

Available colors on 8-bit Linux
(Linux only)

Typically, in Gnome Linux installs running with 8-bit visuals (i.e. 256
color mode), before the Eclipse application is started there are no free
colors. This may mean that Eclipse is unable to allocate the default
widget background color, causing it to display a white background.
The functionality, however, is otherwise unaffected.
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Key bindings can stop working
on Debian (GTK+ only)

On some versions of Debian, Eclipse key bindings may stop working.
In this context the only way to make the key bindings work again is
to restart Eclipse.

The problem is that a focus issue exists in GTK+ 2.6.7 and earlier, for
which SWT has a workaround. This workaround is incompatible with
the GTK+ 2.6.7 fix, so a GTK+ version check is done at runtime to
determine whether the workaround should be used or not. However,
Debian backported the GTK+ focus fix into their libgtk+2.0 (2.6.4-2)
package, so the SWT workaround and GTK+ fix are both incorrectly
applied in this context.

To work around this problem, either get the Debian unstable
version of GTK+, compile your own GTK+, or hack SWT's
Shell.gtk_realize(int) and change the version that it
checks.

Manually installing features
and plug-ins on a FAT file
system (Windows only)

When features and plug-ins are manually installed on top of an
Eclipse-based product install located on a FAT file system that has
already been run at least once, the product must be explicitly restarted
with -clean. That is,

eclipse.exe -clean

Then, open the Help > Software Updates > Manage
Configuration dialog and toggle on the "Show disabled
features" button in its toolbar. Select the newly "installed" feature
and press on the "Enable feature" action on the right pane (or
select the action from the feature's context menu).

Allocating enough memory and
solving OutOfMemoryErrors

By default, Eclipse will allocate up to 256 megabytes of Java heap
memory. This should be ample for all typical development tasks.
However, depending on the JRE that you are running, the number of
additional plug-ins you are using, and the number of files you will be
working with, you could conceivably have to increase this amount.
Eclipse allows you to pass arguments directly to the Java VM using the
-vmargs command line argument, which must follow all other Eclipse
specific arguments. Thus, to increase the available heap memory, you
would typically use:

eclipse -vmargs -Xmx<memory size>

with the <memory size> value set to greater than "256M" (256
megabytes -- the default).

When using a Sun VM, you may also need to increase the size
of the permanent generation memory. The default maximum is 64
megabytes, but more may be needed depending on your plug-in
configuration and use. The maximum permanent generation size is
increased using the -XX:MaxPermSize=<memory size> argument:

eclipse -vmargs -XX:MaxPermSize=<memory size>

This argument may not be available for all VM versions and
platforms; consult your VM documentation for more details.
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Note that setting memory sizes to be larger than the amount of
available physical memory on your machine will cause Java to
"thrash" as it copies objects back and forth to virtual memory, which
will severely degrade your performance.
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Chapter 3. Keys and Registration
Apollo for Eclipse licenses are based on a web services model where licenses are rented rather than
purchased. Rather than purchase a license for a single user for indefinite use, the web services model
'rents' licenses either on a recurring subscription basis or for a single time period. The advantage is greater
flexibility to deploy Apollo for Eclipse on an as-needed basis at a lower cost. Users who need the export
options of Apollo for Eclipse on a regular basis will find the annual subscription to be the most practical
solution. A contract programmer who will only be around for a short time can rent a license for a single
one-month period.

Unlicensed copies of Apollo for Eclipse can be used as cost-free model 'readers' and can also be used
to glean insight into code through the forward, reverse, and roundtrip engineering features. A license is
required for export features like printing and saving.

Types and Terminology
Serial Number - The Serial Number is a unique identifier that is used to generate the registration data
to register the user with a specific copy of the software. The Serial Number must be registered to receive
the License Key.

License Key - These keys are made available after the registration data has been received by Gentleware.
Once a License Key is in place, the registration process is complete. These keys need no further attention,
unless the copy is moved to another machine.

One-Period Rental - Licenses which have been rented for one period are valid until their expiration date.
After the expiration date, export functions are no longer available in Apollo for Eclipse. These licenses
are non-renewable; in order to use the export functions again, another license must be rented and the
registration process repeated.

Rent Subscription - Licenses from a rent subscription are renewed automatically according to the terms
of the rent subscription, e.g. for one year, one quarter, or one month. The renewals continue until the
subscription is cancelled.

License Manager

The license manager pictured here displays (in order of appearance): A serial number for a rent
subscription, a valid license key for a rent subscription, a serial number for a one-period rental, and a valid
license key for a one-period rental.
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• License Type -This column indicates the license type, which could either be a Serial Number or a
License Key.

A Serial Number is provided by Gentleware and is used to generate the registration data necessary for
the registration process in order to obtain a License Key. It is not an actual key to use the software, but
can be used in the interim before the software must be registered.

A License Key is the final license generated during the registration process. Once a License Key is
in place, the registration process is complete. These keys need no further attention, unless the copy is
moved to another machine or is upgraded to another version.

• Product - The name of the product appears in this column.

• Version - If a license is restricted to a specific version, this information will appear in this column. If
the license applies to any version of the listed product, it will display 'Any'.

• Expiration Date - License Keys rented for a single period (month, quarter, or year) have an expiration
date, which is displayed in this column.

License Keys that are rented through the rent subscription service do not expire. The renewal date for
the subscription is indicated in the column titled, 'Key Renewal Date'.

• Key Renewal Date - This column is only relevant for those customers who have taken out a Rent
Subscription.

The license key of a subscription product has to be renewed regularly. This is done automatically every
month, quarter or year, depending on the chosen payment cycle. A precondition for this automatic key
renewal is an active internet connection, otherwise the renewal will have to be manually conducted the
next time there is a working internet connection. Of course, renewal problems will also occur when
payment has not been received for the next subscription period.

In the event of a problem with the renewal for whatever reason, you will still be able to start and work
with the software five additional times.

• Rent Subscription - Users with either a fixed-period rental or a subscription rental will see either 'One
Period' or 'Unlimited', depending on the rental type.

'Unlimited' indicates that this license is an Rent Subscription with periodical recurring charges. 'One
Period' indicates that this license is rented for only one specific time period.

Users who have purchased a license can disregard this field.

• Validity - Validity refers to the status of the Serial Number or License Key. When the correct Serial
Number or License Key is in place, the field will display 'Valid'. An incorrect or outdated key will
display 'Invalid'.

License Manager Help

Help files are available directly in the License Manager. To access these files, click on the question mark
 button in the lower left corner of the License Manager. A Help partition will appear to the right.

From the Help partition, click on 'All Topics' at the bottom of the page. Open the 'Gentleware Product
Registration' tree to view the available files.



Keys and Registration

19

Licensing Apollo for Eclipse
In order to activate the export features of Apollo for Eclipse, a license must be rented from the Gentleware
web shop. After the rental order has been processed, an email with a serial number is sent to you.

1. Open the license manager from the Apollo menu on the main toolbar.

2. Paste the serial number into the license manager and click 'Add Key'.

3. Click on the name of the serial number (it will appear highlighted when selected), then click 'Register'.
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4. Enter your registration information. If you have an active internet connection, click 'Finish' and skip
the rest of these instructions. You are now ready to work with Apollo for Eclipse.

If you are offline, click 'Next'.

5. Select 'Web Registration'. Copy the Registration Data to the clipboard, then click 'Finish'.
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6. Open a web browser on a computer that is online and point it to http://www.gentleware.com/
register.html. Paste the Registration Data into the Registration page of the Gentleware website and click
'Get License Key'.

7. Copy the resulting license key from the web site, paste it into the license manager, and click 'Add Key'.

http://www.gentleware.com/register.html
http://www.gentleware.com/register.html
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After the key has been added, it will display as a valid key in the license manager. You are now ready
to work with Apollo for Eclipse.
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Appendix A. Hypersonic SQL Group
Database Engine License Agreement

 [http://hsqldb.org/]

hsqldb - 100% Java Database

Lightweight 100% Java SQL Database Engine

COPYRIGHTS AND LICENSES

ORIGINAL LICENSE (a.k.a. "hypersonic_lic.txt")

For content, code, and products originally developed by Thomas Mueller and the Hypersonic SQL Group:

Copyright (c) 1995-2000 by the Hypersonic SQL Group. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the Hypersonic SQL Group nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE HYPERSONIC SQL GROUP,
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Hypersonic
SQL Group.

For work added by the HSQL Development Group (a.k.a. hsqldb_lic.txt):

Copyright (c) 2001-2005, The HSQL Development Group All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the HSQL Development Group nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL HSQL DEVELOPMENT GROUP,
HSQLDB.ORG, OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


